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1 Viktigt!

Sakerhet

Information for Europa:
Lar dig de har sakerhetssymbolerna

CAUTION
RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT
REMOVE COVER (OR BACK). NO USER-SERVICEABLE PARTS
INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

A A

Utropstecknet betyder att det finns funktioner
som du bor ldsa mer om i den handbok

som medféljer; for att undvika problem vid
anvandning och underhall.

Blixtsymbolen anger att det finns oisolerade
komponenter i produkten som kan ge en
elektrisk stot.

For att minska risken for brand och elektriska
stotar bor du inte utsétta apparaten for regn
eller fukt och du bor inte heller placera karl
med vatten, exempelvis blomvaser, ovanpa
produkten.

Las de har instruktionerna.
Behall de hir instruktionerna.
Las och ta till dig varningstexten.
Folj samtliga instruktioner.

Anvand inte produkten i narheten av
vatten.

Rengor endast med torr trasa.

Blockera inte ventilationsoppningar.
Installera apparaten i enlighet med
tillverkarens instruktioner.

e O®OEO

©

Ta inte bort produktens holje.

o~

N%

@ Utsitt inte produkten for droppande/
stankande vatten, regn eller hog fuktighet.

Skydda produkten mot direkt solljus,
oppna lagor och varme.

@ Installera den inte i narheten av nagon
varmekalla, som element, varmluftsintag,
spis eller annan elektrisk utrustning
(inklusive forstarkare).

@ Placera inte nagon annan elektrisk
utrustning pa produkten.

@ Placera inga farliga foremal pa enheten
(t.ex. féremal som innehaller vitska, eller
levande ljus).

Produkten kan inkludera batterier.
Se sakerhetsinstruktionerna och
instruktionerna for kassering av batterier
i den har anvandarhandboken.

@ Om natkontakten eller ett kontaktdon
anvinds som frankopplingsenhet ska den
vara ltt att komma at.

1N Varning

* Ta aldrig bort holjet fran apparaten.

* Smorj aldrig ndgon del av apparaten.

* Placera aldrig apparaten ovanpa nagon annan elektrisk
utrustning.

* Skydda apparaten mot direkt solljus, &ppna ldgor och

varme.

Se till att ndtsladden, kontakten och adaptern alltid &r

enkelt tillgéngliga sa att du kan koppla bort apparaten

fran eluttaget.




1N Varning

* For att undvika skador ska du aldrig stoppa fingrarna i
baskanalen (1) eller handerna i aluminiumringen (2).

Risk f6r dverhettning! Installera inte apparaten

i ett trangt utrymme Ldmna alltid ett utrymme
pa minst 10 cm runt apparaten for ventilation.
Se till att gardiner och andra féremal inte tacker
apparatens ventilationshal.

Natsakring

Den hér informationen giller bara produkter
med en natkontakt frdn Storbritannien.

Den hdr produkten har en godkand gjuten
kontakt. Om du byter sdkringen ska du anvdanda
en med:

*  Klassificering synlig pa kontakten,

e den ska vara BS 1362-godkind och

*  ha ASTA-godkdnnandemadrke.

Kontakta aterforséljaren om du dr osdker pa
vilken typ av sdkring du ska anvanda.

Varning! For att uppfylla EMC-direktivet
(2004/108/EG) far ndtkontakten inte skiljas fran
ndtsladden.

Obs!

C€

Anvandning av den hdr produkten
overensstaimmer med EU:s férordningar om
radiostérningar.

C€ 0560 (1) RaTTE Directive 1999I5/EC

BG VRO vV [BE V[IT V[ /]IS V/]SE /|
DK V/IES v [cz VINL /AT VLV /IsK /|

FR VUK VI /IpT /ey /IMT /IPL /]
HU V/INO v/ |GR /sl V[EE V/
T VI V]IE VIcH V/I[DE V

Enheten kan anvdndas i EU utan begrdnsningar
inomhus, men kan inte anvandas utomhus i
Frankrike pa hela frekvensbandet tills nagot
annat tillkdnnages

Den har produkten uppfyller kraven i direktivet
1999/5/EG.
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Andringar

Foérdndringar som inte godkdnts av tillverkaren
kan upphdva anvdndarens behorighet att
anvdnda den hédr enheten.

T

Produkten ar utvecklad och tillverkad av
hogkvalitativa material och komponenter som
bade kan atervinnas och ateranvandas.

)i

Nar den hdr symbolen med en &verkryssad
papperskorg visas pa produkten innebdr det att
produkten omfattas av det europeiska direktivet
2002/96/EG.

Ta reda pa var du kan hitta ndrmaste
atervinningsstation for elektriska och
elektroniska produkter:

Folj den lokala lagstiftningen och sldng inte dina
gamla produkter i det vanliga hushallsavfallet.
Genom att kassera dina gamla produkter pa
ratt satt kan du bidra till att minska eventuella
negativa effekter pa miljé och hdlsa.

)¢

Din produkt innehdller batterier som omfattas
av EU-direktiv 2006/66/EC, som inte far
kasseras som vanliga hushallssopor.Ta reda

pa vilka lokala regler som gller for separat
insamling av batterier eftersom korrekt
kassering bidrar till att férhindra negativ
paverkan pa miljé och hdlsa.

Ssv. 5



Information om batterianvandning:

“ Var forsiktig

¢ Risk for ldckage: Anvand endast den angivna
batteritypen. Blanda inte nya och anvéinda batterier.
Blanda inte batterier av olika marken. Kontrollera
att polerna hamnar at rétt héll. Ta bort batterier ur
produkter som inte anvands under en langre tid.
Forvara batterier pa en torr plats.

¢ Risk for personskada: Anvand handskar nar du hanterar
lickande batterier. Forvara batterier utom réckhall for
barn och husdjur:

* Risk for explosion: Kortslut inte batterier: Utsitt inte
batterier for stark hetta. Slang inte batterier i eld.
Skada inte och ta inte isdr batterier: Ladda inte ej
laddningsbara batterier.

Miljoinformation

Allt onddigt férpackningsmaterial har tagits
bort.Vi har f6rsokt géra paketeringen latt att
dela upp i tre olika material: kartong (ladan),
polystyrenskum (buffert) och polyeten (pasan
skyddande skumskiva).

Systemet bestar av material som kan atervinnas
och ateranvdndas om det monteras isir av ett
specialiserat foretag. Folj de lokala foreskrifterna
for kassering av férpackningsmaterial, anvanda
batterier och gammal utrustning.

-
Made for

\ BiPod [JiPhone [JiPad
[al

AirPlay

“Made for iPod”,"Made for iPhone” och “Made
for iPad” betyder att ett elektroniskt tillbehor
har tagits fram sarskilt for iPod, iPhone eller
iPad, och att utvecklaren har certifierat det for
att uppfylla Apple-standard. Apple ansvarar

inte fér den hdr enhetens funktion eller dess
uppfyllande av standarder f6r sdkerhet och
anvandning. Observera att anvandningen av det
har tillbehdret med iPod, iPhone eller iPad kan
paverka den tradlésa kapaciteten.

AirPlay, iPod och iPhone &r varumérken som
tillhoér Apple Inc,, registrerat i USA. och andra
linder. iPad ar ett varumdrke som tillhér Apple
Inc.

Symbol for klass Il-utrustning:

=

Dubbelisolerad KLASS ll-apparat utan
skyddande jordanslutning.

E Kommentar

* Typplattan sitter pa baksidan av apparaten.




2 Underhallnings-
system

Gratulerar till din nya produkt och védlkommen
till Philips! Genom att registrera din produkt pa
www.philips.com/welcome kan du dra nytta av
Philips support.

Om du kontaktar Phillips behdver du ange
modell- och serienumret till apparaten. Modell-
och serienumret finns pa apparatens undersida.
Skriv numren har:

Modellnummer

Serienr

Introduktion

Med Apple AirPlay-tekniken kan du spela upp
ditt iTunes-bibliotek fran din Mac, PC, iPhone,

iPod touch eller iPad med alla AirPlay-aktiverade

enheter (till exempel din DS3800W) som ar
anslutna till Wi-Fi-ndtverket.

Med en AirPlay-aktiverad enhet (till exempel din

DS3800W) kan du:

e stromma ljud fran iTunes-
musikbiblioteket till valfritt rum
hemma

*  vdlja vilka AirPlay-aktiverade enheter
du vill spela upp musik pa (om du har
fler @n en sadan enhet hemma)

*  strémma ljud till flera AirPlay-
aktiverade enheter samtidigt (endast
fran iTunes-musikbiblioteket pa din
PC/Mac)

5

¢ Information om fler Philips AirPlay-aktiverade enheter
finns pa www.philips.com/welcome.

Med DS3800WV kan du aven:

ladda din iPod/iPhone/iPad via USB-
uttaget med hjdlp av en Apple USB-
kabel (medféljer inte).

spela upp ditt iTunes-musikbibliotek pa
en iPod/iPhone/iPad via USB-uttaget
direkt medan du laddar.

spela upp musik fran andra
ljudenheter via MP3-LINK-uttaget.
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Forpackningens innehall

Kontrollera och identifiera innehallet i
forpackningen:

Huvudenhet (med inbyggd Wi-Fi-
modul)

1 x ndtadapter

1 MP3 link-kabel
Anvindarhandbok (pa CD-ROM)
Snabbstartguide

Dessutom behover du

For att stromma ljud tradlost med AirPlay
behoéver du:

En Wi-Fi-certifierad router

En vérd for iTunes-musikbiblioteket, till
exempel en iPod touch/iPhone/iPad
med iOS 4.3 (eller senare) eller en
PC/Mac med Wi-Fi-funktioner och
iTunes 10 (eller senare)

Din DS3800VV maste vara ansluten till samma
lokala natverk som iTunes-vardenheten via Wi-
Fi-routern.

N% 7



Lista med kompatibla iTunes-
vardenheter for AirPlay

Nar det giller AirPlay dr DS3800WV kompatibel med:

*  enWi-Fi-aktiverad PC/Mac med iTunes 10
(eller senare), och

«  foljande modeller av iPod/iPhone/iPad med
iOS 4.3 (eller senare):

e iPad2

e iPad

*  iPhone 4

e iPhone 3GS

*  iPodtouch (2:a, 3:e, 4:e generationen)

8 SV



Oversikt éver huvudenheten

@

@ Stromindikator

@ o

*  SIa pé/stinga av enheten.

3 »n

*  Starta eller pausa skivuppspelning.
@ +-
* Justera volymen.

*  (Hall bada knapparna intryckta)
aterstdll enheten.

(5 DCIN

*  Anslut ndtadaptern.

@ WI-FI SETUP knapp/indikator
*  Anslut enheten till ett Wi-Fi-ndtverk.
*  Visa enhetens Wi-Fi-anslutningsstatus.

(@) MP3-LINK

*  Anslut en extern ljudspelare med hjélp
av den medféljande MP3 link-kabeln.

USB <

*  Anslut en iPod/iPhone/iPad med hjilp
av en Apple USB-kabel (medféljer
inte).

N% 9
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Borja anvanda AirPlay

For att borja anvdanda AirPlay maste du:

1

10

Uppgradera iPod touch/iPhone/iPad till
den senaste iOS-versionen (I0S 4.3 eller
senare).

*  Ellerinstallera den senaste versionen
av iTunes (iTunes 10 eller senare) pa
din PC/MAC.

Anslut strdmmen till DS3800W och starta.

(se ‘Innan du bdrjar' pa sidan 11)

Anslut DS3800WV till ditt befintliga Wi-Fi-

ndtverk. (se ‘Anslut till ditt Wi-Fi-natverk for

AirPlay’ pa sidan 12)

Se till att din iPod touch/iPhone/iPad eller

PC/MAC ocksa ansluts till samma Wi-Fi-

ndtverk.

N%



3 Innan du borjar

Folj alltid anvisningarna i det hdr kapitlet i ratt
foljd.

Ansluta strommen

n Var forsiktig

* Risk for produktskadal Kontrollera att ndtspanningen
motsvarar den spanning som &r tryckt pa undersidan
av enheten.

* Risk for elektriska stotar! Nar du kopplar bort

ndtadaptern ska du alltid dra ut kontakten ur uttaget.

Dra aldrig i sladden.

Se till att alla andra anslutningar har gjorts innan du

ansluter natadaptern.

*  Anslut ndtsladden till
» uttaget DC IN pa enhetens baksida.
*  vdagguttaget.

Sla pa/av DS3800W
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Starta enheten genom att trycka pa O pa
ovansidan.

Vinta tills enheten har startat upp.

 Uppstarten tar ungefdr 35 sekunder.

— Under uppstart blinkar indikatorlampan
Wi-Fi SETUP pé enhetens framsida
snabbt gront.

> Efter uppstart blinkar indikatorlampan
Wi-Fi SETUP ldngsamt gront om ingen
Wi-Fi-anslutning har konfigureras for
DS3800WV.

Stang av enheten genom att trycka pa O

igen.

sV 11



4 Anslut till ditt
Wi-Fi-natverk
for AirPlay

For att ansluta DS3800WV till ditt befintliga Wi-
Fi-ndtverk maste du tilldmpa din Wi-Fi-instélining
pa DS3800WV.
Du kan gora det pa tva sétt (beroende pa vilken
typ av Wi-Fi-router du anvander):
*  Automatiskt — om Wi-Fi-routern ar
WPS-aktiverad (Wi-Fi Protected
Setup) och stéder PBC (Push Button
Connection) (se ‘Scenario 1: Ansluta
till en WPS-router' pa sidan 12)
*  Manuellt — om Wi-Fi-routern inte
stoder WPS (se ‘Scenario 2: Ansluta till
en icke-WPS-router’ pa sidan 13)
Nar anslutningen har genomfdrts kommer
DS3800WV ihag dina Wi-Fi-instéllningar: Sedan
kan du anvanda AirPlay nar DS3800WV &r pa
och automatiskt anslutet till ditt Wi-Fi-ndtverk.
Innan du ansluter DS3800WV till ditt Wi-Fi-
ndtverk kontrollerar du punkterna nedan.

1 Setill att Wi-Fi-routern ar pa och fungerar
som den ska.

12 SV

2 Setill att DS3800W ir pa och att
uppstarten har slutforts (se ‘Sla pa/av
DS3800W' pa sidan 11).

3 Identifiera typ av Wi-Fi-router (information
finns i Wi-Fi-routerns anvandarhandbok).

Scenario 1:Ansluta till en
WPS-router

E Kommentar

* Innan du trycker pa nagon knapp pa DS3800W bér du
se till att DS3800WV har startat upp som det ska (se ‘Sla
pa/av DS3800W' pd sidan 11).

1 Tryck pa WPS-knappen pa din Wi-Fi-router.

2 Kort efter steg 1 trycker du pa Wi-Fi

SETUP pa baksidan av DS3800WV.

5 |ndikatorn Wi-Fi SETUP blinkar
vaxelvis rétt, gult och gront.

> Inom 2 minuter slutar indikatorn WI-FI
SETUP att blinka och lyser med ett fast
gront sken tills enheten piper.

> DS3800W har anslutits till ditt Wi-Fi-
ndtverk.



* For vissa Wi-Fi- routrar maste du halla WPS-knappen
for Wi-Fi-anslutning intryckt eller aktivera WPS-
PBC-funktionen pa routerns konfigurationssidor. Mer
information finns i anvandarhandbockerna fér de
specifika routrarna.

* Om indikatorn Wi-Fi SETUP pa DS3800WV blinkar gult
har Wi-Fi-anslutningen misslyckats.Vanta i 2 minuter och
forsok igen. Om problemet kvarstar kan du férsoka att
konfigurera Wi-Fi-anslutningen manuellt (se ‘Scenario 2:
Ansluta till en icke-WPS-router’ pa sidan 13).

* Om Wi-Fi-anslutningen misslyckas igen haller du bade
+ och - pa ovansidan av DS3800W intryckta for att
aterstélla och forsoka igen.

Scenario 2:Ansluta till en
icke-WPS-router

E Kommentar

* Du kan dven ansluta DS3800WV till en WPS-router
manuellt genom att folja instruktionerna nedan.

Om du vill ansluta DS3800WV till en Wi-Fi-
router manuellt maste du dppna den inbyggda
konfigurationssidan f6r DS3800W och dndra
de interna Wi-Fi-instéllningarna. Det gor du
med hjdlp av en Wi-Fi-aktiverad enhet med

webbldsare for tillfallig Wi-Fi-anslutning till
DS3800WV. Den Wi-Fi-aktiverade enheten kan
vara en iPod touch/iPhone/iPad eller en Wi-Fi-
aktiverad PC/Mac.

Folj instruktionerna nedan nar du ansluter
DS3800WV till en Wi-Fi-router utan WPS-
funktioner.

1

Skriv ner instéllningarna for Wi-Fi-routern
sa att du har tillgang till dem nér du
konfigurerar Wi-Fi f6r DS3800W (se Ta
fram instdllningarna fér din Wi-Fi-router’ pa
sidan 13).

Stall in DS3800WV pa laget Assisterad

Wi-Fi-konfiguration (se ‘Stéll in DS3800W

pa laget Assisterad Wi-Fi-konfiguration’ pa

sidan 14).

> Ett nytt Wi-Fi-ndtverk som skapas av
DS3800WV visas med ndtverksnamnet
(SSID) Philips Fidelio AirPlay.

Anslut din Wi-Fi-aktiverade enhet till det
nyskapade Wi-Fi-ndtverket tillfdlligt (se
‘Ansluta den Wi-Fi-aktiverade enheten till
det nyskapade Wi-Fi-ndtverket’ pa sidan 14).

Oppna den inbyggda webbsidan fér
DS3800W med hjélp av webbldsaren i din Wi-
Fi-aktiverade enhet (se'Oppna den inbyggda
webbsidan for DS3800W' pa sidan 16).

Andra de interna Wi-Fi-installningarna fér
DS3800WV utifran instéllningarna du skrev
ned i steg 1 (se‘Andra interna Wi-Fi-
instdllningar f6r DS3800W' pa sidan 17).

Aterstill den Wi-Fi-aktiverade enheten

till dina befintliga Wi-Fi-instéllningar (se
‘Aterstilla den Wi-Fi-aktiverade enheten till
dina befintliga Wi-Fi-instéllningar' pa sidan
18).

Ta fram installningarna for din Wi-Fi-
router

E Kommentar

* Ha alitid anvéndarhandboken for din Wi-Fi-router till
hands, dér finns detaljerade instruktioner.

Sv. 13
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1 Anslut din Wi-Fi-aktiverade enhet till det
befintliga Wi-Fi-ndtverket.

2 Starta webblisaren (till exempel Apple
Safari eller Microsoft Internet Explorer) pa
din Wi-Fi-aktiverade enhet.

3 Oppna konfigurationssidan fér din Wi-Fi-
router.
4 Oppna fliken med Wi-Fi-instillningar
och skriv ner féljande information pa ett
papper:
@ Natverksnamn (SSID)
Wi-Fi-sdkerhetsldge (vanligtvis WEP,
WPA eller WPA2)
(© Wi-Fi-lsenord (om Wi-Fi-sakerhet &r
aktiverad)
@ DHCP-lage (aktiverat eller avaktiverat)
@ Instéllningar for statisk IP-adress (om
DHCP-laget ar avaktiverat)

*  Hall Wi-Fi SETUP pa huvudenhetens

baksida intryckt i mer dn 5 sekunder.

> Indikatorlampan Wi-Fi SETUP blinkar
vaxelvis gront och gult.

> Ett nytt Wi-Fi-ndtverk som skapas av
DS3800WV visas med natverksnamnet
(SSID) Philips Fidelio AirPlay.

> Det kan ta upp till 45 sekunder att
skapa det hdr nya Wi-Fi-ndtverket.

E Kommentar

¢ Nar du har konfigurerat Wi-Fi for DS3800W manuellt
férsvinner det nya Wi-Fi-nédtverket som skapades av
DS3800WV.

* Om du misslyckas med att vaxla till laget Assisterad Wi-

Fi-konfiguration stanger du av DS3800WV, startar den

och férscker sedan igen.

Se till att det inte finns nagra andra Philips AirPlay-

aktiverade enheter i ldget Assisterad Wi-Fi-konfiguration

samtidigt. Om flera Wi-Fi-ndtverk skapas pa det har

sattet kan de stora varandra.

Stall in DS3800WV pa laget Assisterad
Wi-Fi-konfiguration

E Kommentar

¢ Innan du trycker pa nagon knapp pa DS3800W bér du
se till att DS3800WV har startat upp som den ska (se
‘SIa pa/av DS3800W' pa sidan 11).

14 SV

Ansluta den Wi-Fi-aktiverade enheten
till det nyskapade Wi-Fi-natverket

Endast en Wi-Fi-aktiverad enhet kan ansluta till

det nya Wi-Fi-ndtverk som skapas av DS3800WV.

Undvik stérning fran andra Wi-Fi-enheter

genom att tillfalligt avaktivera Wi-Fi-funktionen

pa dina andra Wi-Fi-enheter.

Alternativ 1: Anvand iPod touch/iPhone/iPad

1 Valj Settings (Instdliningar) -> Wi-Fi pa din
iPod touch/iPhone/iPad.




3 Vintatills Wi-Fi-anslutningen har upprittats
pa din iPod touch/iPhone/iPad.
L = visas i det Ovre vanstra hornet av
din iPod touch/iPhone/iPad.

Settings
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Tips

* Om Philips Fidelio AirPlay inte star med i listan
forsoker du identifiera tillgéngliga Wi-Fi-ndtverk igen.

Anvianda en Wi-Fi-aktiverad PC/Mac

Kommentar

¢ | anvandarhandboken fér din PC/Mac finns information
om hur du ansluter din PC/Mac till ett Wi-Fi-natverk.

¢ Under anslutningen till Wi-Fi-natverket ska du inte
ansluta ndgon nétverkskabel till din PC/Mac.

ﬁ Wallpaper
) 1 Oppna verktyget for Wi-Fi-konfiguration
eller kontrollpanelen pa din PC/Mac.

n General > 2 Identifiera tillgdngliga Wi-Fi-ndtverk.

2 Vilj Philips Fidelio AirPlay i listan dver
tillgdngliga ndtverk.

setlings ~ Wi-Fi Networks

Searching lor rirsiess rbemsbs inange. .

Philips Fidelio AirPlay

Crvwat

v Philips#delio_Air... T O

3 Vélj Philips Fidelio AirPlay i listan &ver
.. m——— Al | tillgangliga natverk.

>
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4 Vinta tills Wi-Fi-anslutningen har uppréttats
pa din PC/Mac.
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A Securty-snabled sreless neteort. ‘
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(Tl .
¢ Securiy-enabied wedess moba. il

gy ==

Tips

* Om Philips Fidelio AirPlay inte star med i listan
forsoker du identifiera tillgdngliga Wi-Fi-natverk igen.

Oppna den inbyggda webbsidan for
DS3800W

1 Starta webblisaren Apple Safari eller
ndgon annan webbldsare pa din Wi-Fi-
aktiverade enhet.

2 Ange 192.168.1.1 i webbldsarens adressfilt
och bekrifta.

> Konfigurationssidan fér DS3800W
visas.

16 SV

Philips Fidelio

Welcome to Philips FidelR

stepahemmmnnec.l

de\noe name change
Philips Fidelio device name:

Philps_Fidelio 2338FA

Please select your wireless network and enter
your network password if applicable. For
advanced network setup, please click
Advanced; Click Apply to connect your wireless
speaker to your network.

Please select your Wi-Fi network:

| Seiect Cption [

Om du anvinder Safari pa din Wi-Fi-aktiverade
PC/Mac kan du aven valja “Philips_Fidelio
XXX fran listrutan Bonjour och ange
konfigurationssidan for DS3800WV direkt.

1 Kicka pa % -> Preferences (Instdllningar).
> Menyn Bokmarken visas.

- | -

- [#]

Customize Toolbar...

Hide Menu Bar

Hide Bookmarks Bar  Chrl+Shift+8
Hide Tab Biar Chrshift+T
Hide Status Bar Cirl+f
History ChrltH
Downloads Chri+alt+L

Private Browsing.
Reset Safar
Block Pop-Up Windaws  Crrl+Shift+

Help F1
Report Bugs to Apple.

Safar Extensions Gallery
About Safari




2 Markera Include Bonjour i
bokmarkesfiltet.

1 g

il Appaminca.

i s iwal

182.168.1.1

[v]

3 Valj “Philips_Fidelio XXX fran listrutan
Bonjour i bokmarkesfaltet.
> Konfigurationssidan for DS3800W
visas.

Borjour ¥ | Apple  Yahoo!  Go

About Bonjour

Andra interna Wi-Fi-instillningar for
DS3800W

Pa konfigurationssidan for DS3800WV kan

du dndra de interna Wi-Fi- instdliningarna i
DS3800WV for anslutning av DS3800WV till ditt
befintliga Wi-Fi-ndtverk.

Kommentar

¢ Se till att instédllningarna pa konfigurationswebbsidan
Sverensstimmer med de Wi-Fi-instéllningar for
hemndtverket som du skrev ner pa papper.

Pl Fidelo ‘

Welcome to Philips Fidelio setup page. Folow the
#laps below 10 connect your wireless speaker lo your
wirchess network

You can keep the default device name ar
modily the device name by modifying the taxt
in the bext box. Click Apply o procesd with
davice namea change.
Philips Fidelo devics name: Prelen Frome: 1154

ooy

Plaase selact your wirelass natwark and enter
your network password |f applicable. For
advanced network selup, please ciick
Advanced; Click Apply to connect your wireless
spaaker o your network,

Ploass seloct your Wi-Fi notwork:

4 o

m o

*  Folj anvisningarna pa skarmen for att
dndra och bekréfta de interna Wi-Fi-
instdllningarna for DS3800W.
> Efter en stund slutar indikatorlampan
pa baksidan av DS3800WV att blinka
och lyser med ett fast gront sken, och
enheten piper.

> DS3800W dr nu ansluten till ditt
befintliga Wi-Fi-ndtverk.

E Kommentar

¢ Om indikatorlampan WI-FI SETUP p& DS3800W
inte lyser gront har Wi-Fi-anslutningen har misslyckats.
Sténg av bade Wi-Fi-routern och DS3800WV, starta om
dem och forsok ansluta DS3800WV till Wi-Fi-ndtverket.
Om problemet kvarstér forsdker du med ovanstaende
procedur igen.

¢ Naér du har slutfért @ndringarna ovan eller startat om
DS3800W kommer det Wi-Fi-ndtverk som skapades av
DS3800WV att férsvinna.

4

* Om du vill kan du dndra namnet for din DS3800W
under Advanced settings -> AirPlay Device Name
(Avancerade instéllningar -> Airplay-enhetsnamn) pa
konfigurationssidan for DS3800W. Det ér bra att gora
om du har manga Philips AirPlay-enheter i hemmet och
behéver kunna skilja dem at.

¢ Om du vill ange natverksnamnet (SSID) manueltt
(till exempel om du vill délja ditt SSID) gar du till
Advanced settings -> CONFIGURE MANUALLY
(Avancerade instéliningar -> Konfigurera manuelit) pa

konfigurationswebbsidan for DS3800WV.
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Aterstilla den Wi-Fi-aktiverade
enheten till dina befintliga Wi-Fi-
installningar

Kommentar

¢ Setill att instdllningarna i steg 2 till 3 nedan
Sverensstimmer med de Wi-Fi-instélliningar for
hemnétverket du skrev ner pa papper.

1 Vélj Settings (Instdllningar) -> Wi-Fi pa din
iPod touch/iPhone/iPad.
*  Du kan dven oppna listan med

tillgdngliga Wi-Fi-ndtverk pa din PC/Mac.

Settings

ﬁ Wallpaper

i General >

18 SV

2 Vilj ditt natverksnamn (SSID) fran listan
med tillgdngliga tradlosa natverk.

sertings ~ Wi-Fi Networks

3 Ange ndtverksnyckeln om sa behdvs.

4 vanta tils Wi-Fi-anslutningen till ditt Wi-Fi-
ndtverk har uppréttats.



5 U PPS pel nin g 3 Vil Philips_Fidelio XXXX (eller det namn

du har angett) fran AirPlay-listan.
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Stromma ljud fran iTunes-
musikbiblioteket till
DS3800W

Kommentar

¢ Setill att din iTunes-vdrdenhet &r ansluten till samma
Wi-Fi-ndtverk som DS3800W. iTunes-enheten kan vara
en iPod touch/iPhone/iPad med iOS 4.3 (eller senare)
eller en PC/Mac med Wi-Fi-funktioner och iTunes 10
(eller senare).

Cancel

Stromma fran iPod touch/iPhone/iPad

1 starta iPod-programmet pa din iPod 4 Vélj en mediefil och bérja spela upp.
touch/iPhone/iPad. > Efter en stund hors musik fran

DS3800WV.

2 Tryck pa AirPlay-ikonen.

L. "Symphony No. 8 (Scherzo)

@ * Symphony No. 9 (Scherzo)

4« I wI

[A———
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Kommentar

* Om du inte kan héra musik efter slutférd konfiguration
kan du géra nagot av foljande pé iPod touch/iPhone/
iPad:

* (1) Koppla fran och &teranslut till samma Wi-Fi-router
igen;

* (2) Stang alla program som kors i bakgrunden;

* (3) Stang av och starta om iPod touch/iPhone/iPad.

Stromma fran PC/Mac

1 StartaiTunes 10 (eller en senare version)
pa din PC/Mac.

2 Kicka pa AirPlay-ikonen i fonstret.

e

3 Vélj Philips_Fidelio_AirPlay XXXX (eller
det namn du har angett) fran AirPlay-listan.

v [ My Computer

i

Multiple Speakers.

20 sV

4 Vilj en mediefil och bérja spela upp.
L Efter en stund hérs musik fran
DS3800WV.

TR

fili

[

Tips

* Nar du strémmar ljud fran iTunes-musikbiblioteket pa
en PC/Mac kan du vdlja fler @n en AirPlay-aktiverad
enhet (om du har fler) i steg 3 och strémma musik till
dem alla samtidigt.

¢ Om en tidigare version av iTunes anvdnds kanske
ikonen for AirPlay ar € istdllet for [al.

Kontrollera uppspelning

Du kan vilja olika uppspelningsalternativ pa
iTunes-vdrdenheten eller DS3800WV.

Kommentar

* Se till att du strémmar ljud fran iTunes-musikbiblioteket
till DS3800W.

*  Tryck pa » Il om du vill pausa eller
ateruppta uppspelningen.

e Tryck pa + /- flera ganger for att justera
volymen.

Tips

* Om du strémmar musik fran en PC/Mac for att styra
musikuppspelningen fran DS3800W, ska du kryssa i
Allow iTunes audio control from remote speakers
(Tillat iTunes ljudkontroll fran fiarrhégtalare) i Edit ->
Preferences -> Devices (Redigera -> Instéllningar ->
Enheter) pa iTunes.




Anvanda avancerade
ljudinstallningar

Om din iTunes-vardenhet ar en iPod touch/
iPhone/iPad:

For avancerade ljudinstallningar och
tillaggsfunktioner kan du anvdnda din iPod
touch/iPhone/iPad och ladda ned programmet
Philips Fidelio fran Apple App Store. Det ar ett
kostnadsfritt program fran Philips.

Om din iTunes-vdardenhet ar en Wi-Fi-
aktiverad PC/Mac:

For avancerade ljudinstéliningar kan du anvdnda
equalizern som finns i iTunes direkt (View ->
Show Equalizer, (Visa -> Visa equalizer).

Tips

* Mer information finns i hjdlpen fér iTunes.

Spela upp/ladda din iPod/
iPhone/iPad via USB-uttaget

E Kommentar

* USB-uttaget dr endast kompatibelt med iPod/iPhone/
iPad.

Du kan spela upp filer fran eller ladda din
iPod/iPhone/iPad via USB-uttaget med hjdlp av
en USB-kabel (medfdljer inte).

Om du har stoppat ljudstrémning med AirPlay
vaxlar enheten automatiskt till USB-kélla nar
USB-anslutning har uppréttats.
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*  Anslut en Apple USB-kabel (medfdljer

inte) till:

*  USB-uttaget *<5 pa baksidan av
DS3800WV.

*  dockningskontakten pa iPod/iPhone/
iPad.

Kompatibel iPod/iPhone/iPad

Du kan spela upp musik och ladda féljande
modeller av iPod, iPhone och iPad via USB-

uttaget.

e Pad?2

e iPad

e iPhone 4

e  iPhone 3GS
e iPhone 3G

e iPhone

e iPod classic
e iPod 5G

*  iPod 4G

*  iPod nano (2:a, 3¢, 4, S, b
generationen)
* iPod touch (1:a, 2:a, 3:e, 4:e generationen)
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Spela upp fran en extern
enhet

Du kan ocksa lyssna pa en extern ljudspelare via
enheten.

Om du har stoppat bade ljudstrémning med
AirPlay och direkt musikuppspelning via USB-
uttaget vaxlar DS3800WV till MP3 link-kalla
automatiskt.

*  Anslut den medféljande MP3 link-kabeln

till:

*  uttaget MP3-LINK pa enhetens
baksida.

*  Horlursuttaget pa en extern
judspelare.

22 SV



6 Uppdatera fast
programvara

Philips kan komma att erbjuda uppgraderad
fast programvara f6r DS3800WV sa att din
DS3800WV fungerar bittre.

Om du registrerar din produkt pa
www.philips.com/welcome far du information
om den senaste fasta programvaran.

Kommentar

* Du kan bara uppdatera den fasta programvaran fran
en PC/Mac.

Ladda ned uppdateringsfilen

5 e C I

Dl e e e e

"f0|www.philips.com/support| l" I

0 |88 uUnited Kingdom [ English

Register your product / Log in | YXOXXX \I’

]
-]

|
©| & ooxzp

1 Gatil www.philips.com/support pa din PC/
Mac.

2 Ange modellnumret for att hitta den
senaste tillgdngliga uppgraderingsfilen for
fast programvara.

3 Spara uppgraderingsfilen pa harddisken.

Uppdatera fran
konfigurationssidan

'!‘ Varning

* Anslut alltid din DS3800WV till ndtstrém for
uppgradering av fast programvara. Stang aldrig av din
DS3800W under uppgradering av fast programvara.

Kommentar

* Kom ihag att ga till konfigurationssidan for Wi-Fi-
routern och skriva ned IP-adressen for din DS3800W
om du vill anvdnda en annan webbldsare dn Apple
Safari pa din PC/MAC. Information om hur du hittar
IP-adresserna fér de enheter som &r anslutna till Wi-Fi-
routern finns i routerns anvandarhandbok.

1 s pa DS3800WV (se ‘Innan du borjar' pa
sidan 11).
> Det tar cirka 35 sekunder innan
enheten startar Under uppstart
blinkar indikatorn WI-FI SETUP pa
huvudenhetens framsida snabbt gront.

> Efter uppstart hors ett pip och
indikatorn WI-FI SETUP bérjar lysa
med ett fast gront sken. DS3800W
ansluter automatiskt till det senast
konfigurerade Wi-Fi-ndtverket.

2 Se till att DS3800W och din PC/MAC ar
anslutna till samma Wi-Fi-router.

3 Oppna Apple Safari pa din PC/Mac och
vdlj sedan Philips_Fidelio XXX'i den
nedrullningsbara listan f&r Bonjour.

»  Eller 5ppna en annan webbldsare
pa din PC/MAC och skriv sedan in
IP-adressen for DS3800W (finns pa
konfigurationssidan for Wi-Fi-routern)
i adressraden.
> Konfigurationswebbsidan for
DS3800WV visas.
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G

4 Sitfor uppdateringen av fast programvara
genom att folja instruktionerna pa skarmen.

E Kommentar

* Om uppdateringen av den fasta programvaran
misslyckas kan du férsoka utfora atgérden ovan igen.

¢ Om problem uppstar med Wi-Fi-anslutningen efter
uppdateringen av den fasta programvaran haller
du bade + och - pa DS3800W intryckt i mer dn 5
sekunder samtidigt for att aterstélla enheten, och
forsoker sedan konfigurera Wi-Fi-ndtverket for
DS3800W igen (se ‘Anslut till ditt Wi-Fi-natverk for
AirPlay’ pa sidan 12).
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7 Produktinforma-
tion

Kommentar

Allman information

¢ Produktinformationen kan komma att @ndras utan
féregaende meddelande.

Specifikationer

Ntstrém Ingdng: 100 - 240 [
V~, 50/60 Hz
TA12 A -
Utgdng: 12V =
30A

Effektforbrukning vid 30W

anvandning

Stromforbrukning i <05W

standbyldge

Storlek

- Huvudenhet (L x B x H) 198 x 100 x 196 mm

Vikt

- Med forpackning 1,71 kg

- Huvudenhet 1,05 kg

Forstarkare

Nominell uteffekt 4 x 4 Wrms

Frekvensomfang 63 - 20 kHz

Signal/brusférhdllande > 75 dB

MP3 Link 650 mV RMS 20 kohm

Hogtalare

Hogtalarimpedans 8 ohm

Hogtalarelement 40 mm fullt
frekvensomfang

Kanslighet 78 dB/m/W

Tradlost

Trad|os 802.11b/g

standard

Tradlos sakerhet WEP (64- eller 128-bitars),
WPA/WPA?2 (8-63 tecken)

Frekvensomfang 2 412 - 2 462 MHz (CH1-
CH11) (for /179,137,1/55,197)
2412 - 2472 MHz (CH1-
CH13) (for /12,/10,/05)

PBC (en Ja

knapptryckning)
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8 Felsokning

'!‘ Varning

* Ta aldrig bort hdljet fran apparaten.

Forsok aldrig reparera systemet sjdlv. Om du
g6r det géller inte garantin.

Om det uppstar problem vid anvdndningen av
apparaten bor du kontrollera nedanstdende
punkter innan du begir service. Om problemet
kvarstdr gar du till Philips webbplats
(www.philips.com/welcome). Nar du kontaktar
Philips bor du ha bade apparaten samt modell-
och serienumret till hands.

Ingen strom

e Se till att enhetens natkontakt ar korrekt
ansluten.

e Setill att det finns strdm i ndtuttaget.

Inget ljud.

e Justera volymen.

*  Kontrollera anslutningen till Wi-Fi-n&dtverket.
Konfigurera natverket igen om sa kravs (se
‘Anslut till ditt Wi-Fi-ndtverk for AirPlay’ pa
sidan 12).

Inget svar fran enheten

*  Hall bade + och - pa DS3800WV intryckta
i mer dn 5 sekunder for att aterstdlla
enheten. Konfigurera sedan Wi-Fi-ndtverket
for DS3800WV igen (se ‘Anslut till ditt Wi-
Fi-ndtverk for AirPlay’ pa sidan 12).

*  Koppla fran och dteranslut natkontakten
och sld sedan pa enheten igen.

Wi-Fi-natverksanslutning misslyckades

*  Kontrollera om Wi-Fi-routern dr Wi-Fi
802.11b/g-certifierad. Den hdr enheten &r
endast kompatibel med Wi-Fi 802.11b/g-
certifierade routrar.

e OmWi-Fi-routern ar Wi-Fi 802.11n-
certifierad aktiverar du 802.11b/g-laget.
DS3800WV stoder inte anslutning till
routrar med endast 802.11n.
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*  Den hir enheten stoder inte WPS-PIN-
metoden.

*  Om Wi-Fi-routern stéder WPS- och WPS-
PBC-metoderna men inte kan ansluta
till DS3800WV kan du férsdka med den
manuella Wi-Fi-konfigurationsmetoden (se
‘Scenario 2: Ansluta till en icke-WPS-router’
pa sidan 13).

*  Aktivera SSID-sdandning pa WiFi-routern.

*  Hall borta fran potentiella stérningskallor
som kan paverka Wi-Fi-signalen, till
exempel mikrovagsugnar.

*  Om du inte kan anvdnda din PC for Wi-
Fi-konfigurationen kontrollerar du om PC:
n anvander ett Wi-Fi-ndtverk. Du kan inte
anvdnda Ethernet-anslutning for AirPlay-
ndtverkskonfiguration.

*  Se till att hemrouterns SSID-namn bestar
av alfanumeriska tecken, utan infogade
mellanslag eller specialtecken som %/#/*.

*  Om du vdljer att byta namn pa AirPlay-
enheten Philips_Fidelio XXXX i
instéllningsmenyn ska du inte anvdnda
nagra specialtecken eller symboler.

*  Forvissa nya typer av Wi-Fi-routrar kan ett
ndtverksnamn (SSID) skapas automatiskt
nar du ansluter med hjilp av WPS. Andra
alitid standardndtverksnamnet (SSID) till ett
enkelt sadant bestaende av alfanumeriska
tecken och dndra Wi-Fi-sakerhetsldget for
att skydda natverket.

Tillfalliga avbrott i AirPlay-musikstromning

Anvénd ett eller flera av foljande alternativ:

*  Flytta DS3800W ndrmare Wi-Fi-routern.

* Tabort eventuella hinder mellan
DS3800W och Wi-Fi-routern.

*  Undvik att anvdnda Wi-Fi-kanal som
overlappas av det narbeldgna Wi-Fi-
ndtverket.

*  Kontrollera om nétverkshastigheten dr
tillrdckligt snabb (i fall dar flera enheter
delar samma router kan AirPlay-kapaciteten
paverkas). Sting av de andra enheterna
som dr anslutna till din hemrouter.



e Aktivera Quality of Service-alternativet
(QoS) (om tillgdngligt pa Wi-Fi-routern).
e Stdng av andra Wi-Fi-routrar.
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Det visas ingen AirPlay-ikon pa min iTunes-

vardenhet

*  Setill att DS3800W redan dr ansluten till
ditt Wi-Fi-ndtverk.

*  Innan du &ppnar iTunes kontrollerar du att
du har aktiverat Bonjour-tjdnsten i datorn.
Exempelvis Windows XP: aktivera tjansten
genom att klicka pa Start -> Control
Panel (Kontrollpanelen), dubbelklicka
pa Administrative Tools -> Services ->
Bonjour Service (Administrativa verktyg
->Tjdnster -> Bonjour Service) och klicka
sedan pa Start och OK i fonstret som
oppnas.

e Om problemet kvarstar kan du férscka
starta om DS3800WV.

AirPlay-anslutning misslyckades med Mac eller

PC

*  Avaktivera tillfilligt brandvagg och
sakerhetsprogram och kontrollera om de
spdrrar portarna som AirPlay anvander for
strémning. Instruktioner for hur du dppnar
portarna som anvands av AirPlay finns i
dokumentationen till brandvdggen och dina
sdkerhetsprogram.

* Om musikuppspelningen kraschar eller
stannar ndr du anvander iPod Touch/
iPhone/iPad/Mac/PC f6r AirPlay provar du
att starta om din iPod Touch/iPhone/iPad,
iTunes eller DS3800WV.

*  Videostrémning och FTP-hdmtningar kan
Overbelasta routern och darfér orsaka
avbrott under AirPlay-musikuppspelning.
Forsok att minska belastningen pa routern.

Observera! Stombrytaren ar sekundart
kopplad och bryter inte strommen fran nitet.
Den inbyggda natdelen ar darfor ansluten

till elnitet sa linge stickproppen sitter i
vagguttaget.
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